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LUNA 2.0 USER MANUAL
THE LUNA 2.0 DIVE COMPUTER – DESIGNED AND ENGINEERED BY DIVERS FOR DIVERS

Welcome to SCUBAPRO dive computers and thank you for purchasing the LUNA 2.0. You are now the owner of 
an extraordinary partner for your dives. This manual provides you with easy access to SCUBAPRO state-of-the-
art technology and the LUNA 2.0’s key features and functions. Should you wish to know more about SCUBAPRO 
diving equipment, please visit our website www.scubapro.com.

Before using your SCUBAPRO LUNA 2.0, please read and understand the Read First booklet included in the 
package.

 WARNING
• The LUNA 2.0 has a depth rating of 120m/394ft.
• If 120m/394ft is exceeded, “---“ will appear in the depth field and the decompression algorithm will not calculate correctly. 
• Diving at oxygen partial pressures higher than 1.6bar (corresponding to a depth of 67m/220ft when breathing compressed 

air) is extremely dangerous and could lead to severe injury or death.
• Never risk your life on only one source of information. Eventually, every computer has the potential to fail, so do not depend 

exclusively upon it and always have a plan for how to handle failures. Use a redundant dive computer, carry backup tables 
and depth/time instrumentation.

 IMPORTANT
Dive computers provide divers with data; however, they do not provide the knowledge of how this data should be understood 
and applied. Dive computers cannot replace common sense! You must therefore carefully read and understand this entire 
manual before using your LUNA 2.0.

Hereby, Uwatec AG declares that the radio equipment type PAN1740A is in compliance with Directive 2014/53/EU.
The LUNA 2.0 dive instrument is also compliant with the European Union directive 2014/30/EU.
The full text of the EU declaration of conformity is available at www.scubapro.com/declarations-conformity.
Standard EN 13319: 2000
EN13319 is a European diving depth gauge standard. SCUBAPRO dive computers are designed to comply with this standard.
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All rights reserved. Under the copyright laws, this manual may not be copied, in whole or in part, without the written consent of SCUBAPRO. 
SCUBAPRO reserves the right to change or improve its products and to make changes to the content of this manual without obligation to notify 
any person or organization of such changes or improvements. Go to www.scubapro.com for current updates and supplemental information 
concerning the use of this product.
LogTRAK, the Human factor diving™ and SCUBAPRO are trademarks of Johnson Outdoors Inc.
Android™ is a trademark of Google LLC. Apple® , iPhone® , and Mac® are trademarks of Apple Inc., registered in the U.S. and other countries. 
The BLUETOOTH® word mark and logos are owned by Bluetooth SIG, Inc. and any use of such marks by Johnson Outdoors is under license. 
iOS® is a registered trademark of Cisco Systems, Inc. used under license by Apple Inc. Windows® is a registered trademark of Microsoft 
Corporation in the United States and other countries.
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1 . INTRODUCTION TO THE LUNA 2.0 DIVE COMPUTER
There are two versions of the LUNA 2.0, and in the following chapters this user manual describes the LUNA 2.0, 
the version without air integration and heart rate module.
The LUNA 2.0 is a sleekly designed and ergonomically shaped dive computer with selectable ZH-L16 ADT MB 
PMG and ZH-L16C+GF PMG algorithms, user updateable firmware, user replaceable battery, high contrast black 
and white matrix-segment display, and Bluetooth low energy interface.

1 .1 Switching on and off the LUNA 2.0

 IMPORTANT
The LUNA 2.0 is delivered in deep sleep mode where the display is off. You must activate it with a long-press of both left and 
right buttons before the first dive.

After being woken up from deep sleep the LUNA 2.0 can be switched on manually, by simultaneously pushing and 
holding the left and right buttons.

After switching on, the display shows the following information:
• dive computer name
• date
• day of week
• battery status
• temperature
• time of day
• selected dive mode (diver icon)
This is referred to as the surface screen.

In the surface screen, if there is remaining saturation from the last dive or from a change of altitude, the LUNA 2.0 
may indicate the “Do not fly” icon, “Do not dive” icon or “Altitude” icon or a combination of the icons depending on 
the situation.

In the above screen the vertical bar in the right side of the display represents the tissue saturation: 
• 6 bars = full saturation
• No bar = desaturation complete

F NOTE: When the LUNA 2.0 is in a state of rest, no information is displayed but the atmospheric pressure 
continues to be monitored. Without active use the LUNA 2.0’s display automatically reverts to the surface 
screen, and after 5 minutes the computer switches off. You can also turn off the LUNA 2.0 manually from the 
surface screen by a long-press of the left button.
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F NOTE: After turning the LUNA 2.0 on for the first time, do not turn it off manually but rather wait until it switches 
off automatically.

1 .2 Quick reference of the display layout

m
ft
MAX
 Ba�ery icon

Do not fly iconDo not dive icon

Al�tude symbol

Dive �me 
SOS dura�on
No-fly �me

Temperature
O2 mix Time of day

Display matrix area

Dive mode

Alarm / Warning symbol

Water detec�on symbol

Dive depth

Al�tude classesCNS% No-stop �me (NST)

Time format AM/PM

No-dive �me 

Ascent / Descent symbol

Satura�on / Ascent speed bar

Altitude symbol

Display matrix area

Do not fly icon

Dive time
SOS duration
No-fly time

Battery iconDive mode

Alarm / Warning symbol

Dive depth
No-dive time

Temperature
O2 mix
CNS%

Saturation / Ascent speed bar

Time format AM/PM

Water detection symbol

Time of day
Altitude classes
No-stop time (NST)

Ascent / Descent symbol

Do not dive icon

The diver symbol in the image above represents the selected dive mode as follows:

SCUBA mode

APNEA mode

GAUGE mode

1 .3 Operating modes

The LUNA 2.0 has 3 operating modes:
• Sleep mode. In this mode the display is off, but the LUNA 2.0 still updates desaturation and monitors ambient 

pressure for altitude changes, etc. This mode is activated automatically at the surface after 5 minutes without 
operation.

• Surface mode. After a dive or when manually activated, the display is on, and you can change settings or 
operate the LUNA 2.0 with its buttons. 

• Dive mode. This mode is activated when the computer reaches a depth of 0.8m/3ft or more. In this mode the 
LUNA 2.0 monitors depth, time, and temperature. Decompression calculations are performed in this mode.
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1 .4 Button operation

The LUNA 2.0’s features are accessed and controlled with 2 pushbuttons. Operation of these pushbuttons is 
divided into 2 methods: “press” and “press-and-hold” (for 1 second) – also referred to as a “long-press”. Each 
method allows you to access different computer functions.

On the surface:

Long-press left and 
right buttons

Long-press left 
button

Short press left 
button

Long-press right 
button

Short press right 
button

Switch on the dive 
computer from sleep 

mode

From surface screen 
switch off dive 

computer

Scroll up in menu 
structure

Enter main menu and 
submenus

Scroll down in menu 
structure

Activate backlight
Cancel setting or 

selection

Decrease value 
/ scroll through 
settings options

Confirm setting or 
selection

Increase value / scroll 
through settings 

options

Return from menus 
and submenus

Switch to previous 
screen in matrix area 

(e.g. after a dive 
there are multiple 

selectable screens)

Switch to next screen 
in matrix area (e.g. 

after a dive there are 
multiple selectable 

screens)
From surface screen: 
access current dive 

settings

1 .5 Water contacts

The water contacts allow the LUNA 2.0 to automatically turn on the moment it senses the presence of water. This 
means that you can jump in the water at any time without having to worry whether the computer is turned on or 
not. The water contacts can be found near the top left and right corners of the display, as pointed out in the image 
below.
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F	NOTE: When replacing the protection foil on the LUNA 2.0’s display, take care not to cover the water contacts!

If the dive is not started within 5 minutes of activating the water contacts, the LUNA 2.0 will automatically switch 
off again.

1 .6 Battery

The LUNA 2.0 uses a user-replaceable CR2450 type battery. Please refer to chapter Replacing the battery in the 
LUNA 2.0 to learn how to replace the dive computer’s battery.
The battery capacity is constantly displayed on the LUNA 2.0’s surface screen. When the battery is approaching a 
critical discharge level the LUNA 2.0 will warn you by a blinking battery symbol. The LUNA 2.0’s intelligent battery 
algorithm will limit some functions as you near the end of the battery’s life. See the table below for battery status 
and corresponding function limitations.

Battery icon Battery status Function limitations

Fresh battery none

Battery ok for diving none

Battery ok for diving none

Weak battery, change to fresh
Backlight not operating 
diving not recommended

Completely used battery, change to fresh 
LUNA 2.0 may make a reset any time and 
remain off

Dive will not start

 WARNING
Starting a dive when the battery symbol is blinking can cause the computer to fail during the dive! Replace the battery before 
any diving activity if the blinking battery symbol appears. When the battery symbol is blinking with one bar left the LUNA 2.0 
cannot be used for diving until a fresh battery is installed.

 WARNING
The LUNA 2.0 will not start a dive if the battery has reached the critical level indicated by the battery empty warning. In this 
state the LUNA 2.0 cannot be used for diving.

1 .7 Battery Safety Instructions 

• Do not ingest the battery, chemical burn hazard!
• This product contains a coin/button cell battery.
• If the coin/button cell battery is swallowed, it can cause severe internal burns in just 2 hours and can lead to 

death.
• Keep new and used batteries away from children. If the battery compartment does not close securely, stop 

using the product and keep it away from children.
• If you think batteries might have been swallowed or placed inside any part of the body, seek immediate 

medical attention.
• Do not expose the product or battery to excessive heat, including direct sunlight or fire. Do not store or use 

inside cars in hot weather, where it can be exposed to high temperatures.
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2 . LUNA 2.0 SETTINGS AND MENUS ON THE SURFACE
In this chapter, the surface settings are described. These settings will allow you to personalize your LUNA 2.0 as 
desired.
The menu structure of the LUNA 2.0 is arranged as seen in the below chart:

Time & Date
Water

Decoalgo

MB-Level
or

G Factor

PDIS

Scuba

PMG

Mode

Scuba

Gauge

Apnea

Altimeter

Logbook

Bluetooth Gas

Gas Mix Set Gas 1 Set Gas 2 Set Gas 3

PPO2max 

O2 Reset

PPO2max 1 PPO2max 2 PPO2max 3

Apnea

Total Ex

SIF

Depth

Dive Inc

Dive Int

Surf Int

Speed

St. Apnea

Dive Time

Depth

MOD

Light

Warning

Set UTC

Set Time

Set Date

Format

Clock

Buzzer

Sound

Button

Light-up

Light

Units

Owner

Desat

Service

Settings

User

Dive

Planner

Time & Date

In each menu the current selection will be highlighted (black text on white background) and will stay in the middle 
of the screen as you scroll up or down. 

Selecting “RETURN” in a menu or submenu has the same function as a long-press of the left button; it will return 
you to the previous menu or submenu or from the main menu to the surface screen.

F	NOTE: Depending on the selected decompression algorithm, the LUNA 2.0 will either display MB-level or G 
Factor settings in the SCUBA submenu.

F	NOTE: The menu PDIS is only available if the adaptive decompression algorithm is selected.

2 .1 Dive settings on surface

In this menu you can set your dive-related preferences, like selecting dive mode, choosing the decompression 
algorithm, or setting warnings and alarms.
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2 .1 .1 Dive mode selection

The menu Mode allows you to select your preferred dive mode: APNEA, SCUBA or GAUGE mode.

 

F	NOTE: GAUGE and APNEA modes do not track tissue saturation so there is a locking interval before it is 
possible to change to SCUBA mode. In GAUGE mode the locking interval is 48h after the last dive. In APNEA 
mode there is a 12h locking interval with shallower than 5m/16ft dives, and a 24h locking interval with deeper 
than 5m/16ft dives.

2 .1 .2 Scuba mode settings

A set of SCUBA related settings are grouped in this menu.

2.1.2.1 Water type selection

The LUNA 2.0 determines depth by measuring pressure using water density as a constant. A 10m/33ft depth in 
salt water corresponds approximately to 10.3m/34ft in fresh water. In this menu you may select either salt or fresh 
water.

 

F	NOTE: This setting will adjust the depth for all dive modes: SCUBA, GAUGE and APNEA.
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2.1.2.2 Decompression algorithm selection

In this menu you can choose your preferred decompression algorithm. The LUNA 2.0 offers the ZH-L16 ADT MB 
PMG and ZH-L16C+GF PMG algorithms. The algorithm selection needs to be confirmed with the safety code 313.

 

 

 WARNING
Diving with the Gradient Factor algorithm requires advanced know-how about decompression theories, their suitability for the 
planned dives and matching to your body. Wrong values can lead to decompression sickness, permanent injury or death.

2.1.2.3 Microbubble level selection

Here you may select the preferred Microbubble (MB) level that you want to follow during your dives. Level 5 is the 
most conservative, Level 0 is the least conservative. 

 

F	NOTE: The menu MB-LEVEL and the settings related to microbubble levels are only active while the ZH-L16 
ADT MB PMG algorithm is selected in the DECOALGO menu.

F	NOTE: See chapter Diving with MB-levels to learn more about diving with the adaptive algorithm.
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2.1.2.4 Gradient Factor settings

Here you may select the preferred Gradient Factor setting that you want to follow during your dives. GF low can be 
set from 5 to100 and GF high from 50 to100.

 

 

F	NOTE: The menu GFACTOR and the settings related to gradient factors are only active while the ZH-L16C+GF 
PMG algorithm is selected in the DECOALGO menu.

F	NOTE: See chapter Diving with Gradient Factors (GF) to learn more about diving with the GF algorithm.

2.1.2.5 Enabling PDIS

SCUBAPRO dive computers feature Profile-Dependent Intermediate Stops (PDIS) which can be turned on or off in 
this menu.

 

See chapter PDIS (Profile-Dependent Intermediate Stop) to learn more about this feature.

F	NOTE: The PDIS setting is only available when the adaptive algorithm (ZH-L16 ADT MB PMG) is selected in the 
menu DECOALGO.
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2.1.2.6 Enabling predictive multi-gas mode (PMG)

Predictive multi-gas (PMG) mode enables the use of multiple tanks (up to 3 tanks).

 

See chapter Diving with multiple gas mixtures to learn more about how to use this feature.

2 .1 .3 Apnea mode settings

A series of APNEA related settings are grouped in this menu.

 

2.1.3.1 Total Apnea exercise depth

To provide a scale of total pressure changes during an APNEA dive session, the LUNA 2.0 includes a total depth 
counter. Using the pushbuttons you can set the total depth counter from 100m/300ft to 1000m/3301ft. When your 
depth total has been reached the LUNA 2.0 notifies you at the surface with an audible tone and a blinking “no dive” 
symbol to let you know it is time to end the session and take a break.

 

2.1.3.2 Surface Interval Factor (SIF)

APNEA diving organizations provide various recommendations regarding surface intervals between dives based 
on dive times or depths. The LUNA 2.0 integrates a surface interval counter which employs simple multiplication 
for determining the surface interval in seconds. The LUNA 2.0 uses the following formula to make this calculation: 

Surface interval before the next dive = pressure (depth) * square root of dive time * SIF. 
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As a reference, a few values are listed in the following table:

DIVE DEPTH DIVE SURFACE INTERVAL

m ft seconds
seconds  
(SIF = 5)

seconds  
(SIF = 20)

10 30 40 63 253

10 30 60 77 309

20 60 60 116 464

30 90 80 178 716

40 120 90 237 949

F	NOTE: The actual depth and time are calculated during the ascent and descent. This is not presented in the 
table above.

 

The SIF can be set from 5 to 20 or disabled with the OFF setting.

2.1.3.3 Dual depth alarm
In initial factory settings the dual dive depth alarm is switched off. 

Once you have enabled this feature by selecting “AUDIBLE” the first depth setting will be shown. 

 

Both depth alarms can be set from 5 to 100 meters (20 to 330 feet) in 1m/5ft increments. By long-pressing the right 
button the first value is confirmed, and the second depth can be adjusted.
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In the upper left section of the screen, the depth of the first alarm is displayed.

2.1.3.4 Dive depth incremental alarm
In initial factory settings the dive depth incremental alarm is switched off.
You may select the alarm value from 5 to 100m (20 to 330ft) in 1m/5ft increments, and the direction can be selected 
as UP/DOWN/BOTH. After selecting the direction, the depth can be set.

 

 

2.1.3.5 Dive time interval alarm
In this menu you may enable or disable the dive time interval alarm by choosing AUDIBLE or OFF. By selecting 
AUDIBLE you can set the interval from 15 seconds up to 10 minutes in 15 second increments.
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2.1.3.6 Surface interval alarm
In this menu you may enable or disable the surface interval alarm by choosing AUDIBLE or OFF. By selecting 
AUDIBLE you can set the interval from 15 seconds up to 10 minutes in 15 second increments. 

 

2.1.3.7 Ascent speed alarm
In this menu you may enable or disable the ascent speed alarm by choosing AUDIBLE or OFF. By selecting AUDIBLE 
you can select the interval from 0.1 to 5.0 meters/second (1 to 15 feet/sec) in 0.1m/sec (1ft/sec) increments. 
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2.1.3.8 Manually starting an Apnea dive (ST. APNEA)
Apnea exercise mode can be manually started from the Dive -> St. Apnea menu. The session starts with a surface 
interval.

 

Display information and diving with this mode is described in chapter Diving in APNEA mode.

F	NOTE: Manually starting an apnea dive will automatically change the dive mode to Apnea.

2 .1 .4 Warning settings
There are four warnings which can be enabled and edited directly in the LUNA 2.0. The rest of the warnings can 
only be enabled / disabled via SCUBAPRO LogTRAK. To learn more about the warnings see chapter Alarms and 
warnings during diving.

2.1.4.1 Dive time warning
In initial factory settings the dive time warning is switched off. The dive time warning can be adjusted from 5 to 195 
minutes in 5-minute increments.

 



21

En
gl

is
h

LUNA 2.0 USER MANUAL

2.1.4.2 Dive depth warning
In initial factory settings the dive depth warning is switched off. The dive depth warning can be adjusted from 5 to 
100m (20 to 330ft) in 1m/5ft increments.

 

2.1.4.3 Maximum operating depth warning (MOD)
In initial factory settings the MOD alarm is enabled. Disabling the alarm requires the safety code 313 in order to 
prevent accidental switching off.

 

The MOD alarm uses the maximum ppO2 value which is given in the gas settings and the default value is 1.4bar.

 WARNING
Diving at oxygen partial pressures higher than 1.6bar is extremely dangerous and could lead to severe injury or death.

2.1.4.4 Setting the visual warning signal
In this menu you can set the LUNA 2.0’s function to warn you by lighting up the display backlight in a bright red color 
in case a warning or alarm is triggered. The warning contrast can be adjusted from 1 to 4 or can be disabled by 
setting it to OFF. This is an additional feature to the audible warning signals, which can help make you more aware 
of the presence of a warning in the event the audible sequence is not heard.
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2 .2 General settings

In the Settings menu the following functions can be set:
• Clock settings – setting the UTC, time, date, and time format.
• User settings – workload, backlight, display contrast, units, owner info, desaturation reset, service check, 

current software version.
• Sound settings – enable or disable button beeps, dive warnings.

2 .2 .1 Clock settings
From the main menu, toggle down to Settings with the right button, then long-press the right button to enter. 
Select Clock to enter the clock settings.

F	NOTE: You can also adjust the clock settings in the LogTRAK mobile app under Dive Computer Settings -> 
Personalization -> Clock.

2.2.1.1 Setting UTC
The UTC setting will change the displayed time compared to Greenwich 0-Meridian. This feature is practical 
when traveling through different time zones. By long-pressing the right button you may edit the hours with the 
pushbuttons in a range of +14h to -13h. By long-pressing the right button you confirm the hours, and the minutes 
will be highlighted. The minutes can be edited in 15-minute increments.
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2.2.1.2 Setting the time
By entering the Set Time submenu, the time setting will be activated. You may change the hours and the minutes 
using the pushbuttons.

 

F	NOTE: The seconds cannot be edited, they always start counting from 0.

2.2.1.3 Setting the date
By entering the Set Date submenu, the first two digits will be highlighted. You may edit them using the pushbuttons. 
Change the selection to the next two digits by long-pressing the right button. Finally, set the year and confirm the 
settings. In 24h time format the first digits in the date are days, in AM/PM time format the month is first.

 

2.2.1.4 Time format
By entering the Format submenu, you can choose your preferred time format between AM/PM or 24-hour format. 
Save your settings with the right button.

 

F	NOTE: Time format will also change the date format: mm/dd/yyyy in AM/PM format and dd.mm.yyyy in 24h 
format. This change will affect, for example, the dates of your dives in your logbook.
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2 .2 .2 User settings
In this menu you can customize your LUNA 2.0 to your liking. Settings like backlight duration, display contrast and 
units can be changed here.

2.2.2.1 Light-up
Enter the Light-up submenu to access the backlight settings. In this menu you can define how long the backlight 
will light up to full brightness when pressing both buttons. The duration of the backlight can be set between 5 and 
30 seconds.

 

F	NOTE: The backlight is disabled when the battery level is getting critically low.

2.2.2.2 Light
Enter the Light submenu to access the backlight brightness settings. Contrast can be set between 1 and 5 or can 
be disabled by setting it to OFF.
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2.2.2.3 Units
Different combinations of temperature, air pressure and height or depth measurement units can be selected in the 
Units submenu.

 

F	NOTE: You can also adjust the unit settings in the LogTRAK mobile app under Dive Computer Settings -> 
Personalization -> Units.

2.2.2.4 Owner information
In this submenu you can access and display owner information, like name, contact details, birthday, etc. We 
recommend that you enter some kind of contact information (e-mail address and/or phone number) in case you 
lose or misplace your dive computer.

 

You can enter owner’s information using the LogTRAK mobile app under Dive Computer Settings -> 
Personalization -> Owner info.
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2.2.2.5 Reset desaturation
When the LUNA 2.0 is still counting down the desaturation, some menu changes are not possible. In case you wish 
to reset the desaturation, the safety code 313 must be entered. This procedure prevents unwanted resetting and 
will write desaturation reset in the memory (in the next dive log the desaturation symbol will be shown).

 

2.2.2.6 Service information
The date of the last service by an authorized SCUBAPRO dealer is shown in this submenu.

 

F	NOTE: Only an authorized SCUBAPRO service center, which has the proper tools and instruments, can reset 
the service date. The service date is only set after the LUNA 2.0’s seals are checked and verified.

Pressing the left button from the “last service” screen will display the current software version of the LUNA 2.0. 

By further scrolling from the “software version” screen the Bluetooth version information will be displayed (FCC ID).
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2 .2 .3 Sound settings
In this menu you can enable or disable button beeps, dive warnings and alarms.

2.2.3.1 Buzzer
When delivered with factory settings the LUNA 2.0’s buzzer is active. You can set the dive computer to silent mode 
in the Buzzer submenu which deactivates all sounds. However, switching off all alarm sounds requires the safety 
code 313 to prevent accidental deactivation.

 

 WARNING
Deactivating the buzzer will disable all audible dive alarms and warnings. This could potentially be dangerous.

2.2.3.2 Button beeps
In the Buttons submenu the general button feedback beeps can be enabled or disabled.
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2 .3 Gas settings

In the Gas menu you can change the gas content of the tanks that you are using as well as the partial pressure 
limit of the gas. The Maximum Operating Depth (MOD) limit will be shown for the values you have selected. To learn 
more about diving with Nitrox and MOD, see chapter Diving with Nitrox.

2 .3 .1 Setting gas oxygen content
In the gas menu you can change different nitrox mix settings or enable multi-gas functions (when PMG is set to ON 
in DIVE->SCUBA->PMG).

Setting Gas 1
Enter the submenu Set Gas 1 and adjust the O2 content with the left or right buttons. Gas 1 can be set from 21% 
oxygen (Air) up to 50% oxygen. 

 

F	NOTE: In this screen the MOD is also displayed and will adjust automatically depending on your O2 and 
PPO2max settings.

F	NOTE: Gas 1 cannot be disabled. 

Setting Gas 2
Enter the submenu Set Gas 2 and select ON by long-pressing the right button, then adjust the O2 content of your 
tank from 21% to 100%. 
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F	NOTE: Gas 2 can be disabled by selecting OFF in the menu. 

F	NOTE: Gas 3 can be set or disabled the same way as Gas 2.

If the PMG setting is disabled (see chapter Enabling predictive multi-gas mode (PMG)) the submenus Set Gas 
2 and Set Gas 3 are not available. Then the menu Gas Mix will appear as follows: 

2 .3 .2 PPO2max
The ppO2 maximum value is required for the MOD limit you intend to use for gases 1 to 3. The factory setting is 
1.40bar. 

Setting PPO2max 
Enter the submenu PPO2max 1 and adjust the setting with the left or right buttons. It can be set from 1.20bar to 
1.60bar.
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F	NOTE: In this screen the MOD is also displayed and will adjust automatically depending on your PPO2max 
settings.

PPO2max 2 and PPO2max 3 can be set the same way as PPO2max 1.

F	NOTE: If Gas 2 is set to OFF the settings in the PPO2max 2 submenu are disabled.

F	NOTE: If Gas 3 is set to OFF the settings in the PPO2max 3 submenu are disabled.

If the PMG setting is disabled (see chapter Enabling predictive multi-gas mode (PMG)) the submenus PPO2max 
2 and PPO2max 3 are not available. Then the menu PPO2max will appear as follows: 

F	NOTE: The ppO2 is fixed to 1.6bar when the selected oxygen content is 80% or higher.

2 .3 .3 Nitrox reset time
If you are usually diving with air and want to return to this setting after the occasional nitrox dive, you can preset a 
default time when your LUNA 2.0 will set back to air. 
By entering the O2 reset submenu you can set the reset time from 1 hour up to 48 hours. The nitrox reset time is 
disabled when -- h is shown on the display.
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2 .4 Bluetooth

In this menu you can enable Bluetooth communication between your LUNA 2.0 and a handheld device or desktop 
computer. To learn how to establish Bluetooth communication refer to the chapter Establishing Bluetooth 
communication.

2 .5 Reading the altitude, barometric and temperature values

In this menu on the first screen the current altitude (in meters or feet) is calculated from the barometric pressure and 
shown in the middle of the screen. The air pressure (in mbar) at your current altitude is also displayed in the middle 
section of the screen.

 

The altitude can be adjusted when current elevation is known. With a long-press of the right button the altitude 
value in the center of the screen can be adjusted in 5m/16ft increments. 

F	NOTE: Barometric pressure is a variable, changing with weather and atmospheric pressure at a particular 
elevation. The dive algorithm uses altitude classes which are directly derived from the barometric pressure. 
Altitude is counted from the current barometric pressure and is therefore a relative value.

By pressing one of the pushbuttons you can switch to the next screen where the atmospheric pressure at sea level 
is shown.
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The Barometer feature allows you to foresee approaching weather in the upcoming hours if your altitude remains 
the same.

2 .6 Planning a dive

You can plan your next dive based on your body’s nitrogen saturation. The planner is also using the following 
information: 
1. Selected oxygen concentration. 
2. Selected water type. 
3. Selected microbubble level or GF setting.
4. Water temperature of the most recent dive. 
5. Altitude range. 
6. Status of saturation at the time when the planner is activated. 
7. Observance of the prescribed ascent rates. 
To set up a new dive plan, enter the Planner menu.

F	NOTE: When the LUNA 2.0 is in GAUGE or APNEA mode, the dive planner is disabled.

2 .6 .1 No-stop plan
If you have completed a dive but plan to make another during the desaturation phase, you must start the planner 
by adding the time you would otherwise be on the surface. The time can be added in 15-minute increments.

The prohibited altitude class is shown after the current elevation at the bottom line. For more information on altitude 
diving with the LUNA 2.0, see chapter Altitude diving. In case the LUNA 2.0 is displaying the no-dive warning, the 
duration of the warning itself is displayed as a recommended surface interval for planning purposes (rounded up to 
the nearest 15-minute increment).
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When the surface interval is given, or if you have no remaining desaturation left, the planner shows the depth in 
3m/10ft increments and can be increased or decreased using the push-buttons. The no-decompression dive time 
is shown for that depth. The current gas mix is shown on the bottom row.

CNS% value replaces the gas mix on the bottom left of the screen when 1% would be reached for that depth with 
maximum no-stop time.

F	NOTE: The minimum depth for dive planning is 9m/30ft. The planner allows only depths in line with maximum 
ppO2. The oxygen content and maximum ppO2 settings are given in the menu GAS.

2 .6 .2 Decompression plan
After confirming the planned dive depth, the planned dive time can be set. 
In the below image the planned dive time is 25 minutes.

The start point is the “no decompression” time. The deepest decompression or level stop (LVL) is also shown as 
well as the Total Ascent Time (TAT).
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2 .7 Reading the logbook

You can review your dive statistics by entering the Logbook menu.

On the screen below, the LUNA 2.0 has 22 dives and a total of 23 hours of diving in the Logbook, with the deepest 
dive at 21.9 meters and the longest dive time of 73 minutes.

By pressing the left or right buttons you will enter the repository of the logs where you can scroll through your dives. 
The below display shows the following information: 
• Maximum depth reached (20.4 m),
• Dive time (23 minutes),
• Dive mode (SCUBA),
• Number of gases (2G),
• Time at start of dive (13:26),
• Date (06.10.22)
• Altitude class (C0)
• Dive number (n1)

By long-pressing the right button on the above screen the LUNA 2.0 will display the graphical profile of the dive.



35

En
gl

is
h

LUNA 2.0 USER MANUAL

With a further press of the right pushbutton the following information will appear as in the screen below:
• Counted repetitive dive (rep 1)
• Start and finish of the dive (in/out)
• MB-level (L5)

F	NOTE: The capacity of the LUNA 2.0’s logbook is around 50 hours with a 4-second sampling rate.
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3 . DIVING WITH THE LUNA 2.0 
The LUNA 2.0 is a full-featured dive computer capable of multi-gas Nitrox decompression calculations, ascent rate 
calculations and warnings. During a dive the LUNA 2.0 displays information such as depth, dive time, decompression 
status, water temperature, and much more. On the surface after a dive, remaining desaturation time, no-fly time, 
surface interval and prohibited altitude classes are shown in addition to the time and date information. 
Note that the LUNA 2.0 can be set to three dive modes: SCUBA, APNEA and GAUGE. Due to the operational 
differences between modes, the buttons will have different functions depending on which mode you are using. 
The functions of the buttons during diving are summarized in the table below:

Dive 
mode

Long-press  
left & right 

buttons

Long-press  
left button

Short press  
left button:

Long-press  
right button:

Short press  
right button

S
C

U
B

A

Activate backlight

Exit gas selection  
(PMG: ON)

Set bookmarks

Reset timer

Select previous gas 
(PMG: ON)

Select previous dive 
screen

Enter gas selection 
(PMG: ON)

Confirm gas 
change auto 
suggestion  
(PMG: ON)

Warning 
confirmation

Pause & restart 
timer

Select next gas  
(PMG: ON)

Select next dive 
screen 

G
A

U
G

E

Activate backlight
Reset timer

Set bookmarks

Select previous dive 
screen

Pause & restart 
timer

Select next dive 
screen

A
P

N
E

A

Activate backlight

Set bookmarks

In surface interval: 
end Apnea exercise

Select previous dive 
screen

Select next dive 
screen

3 .1 Display information

Upon immersion, the LUNA 2.0 will automatically start to monitor the dive regardless of what state it was in prior to 
the immersion. Details on the information displayed can be found in the next sections.
Dive time: the dive time is displayed in seconds in APNEA mode and in minutes in SCUBA and GAUGE modes. If 
during the dive you ascend to the surface, the time spent on the surface will only be counted to the dive time if you 
descend again below 0.8m/3ft within 5 minutes. This allows for brief periods of orientation. While on the surface, 
the time will not show as progressing, but it is running in the background. As soon as you submerge, the time 
will resume, including the time spent on the surface. If you spend more than 5 minutes at a depth shallower than 
0.8m/3ft, the dive will be considered ended, it is stored in the logbook and a subsequent immersion would cause 
the dive time to start again from zero.
The maximum displayed dive time is 999 minutes. For dives longer than that, the dive time starts again from 0 
minutes.
Depth: the depth is displayed in 0.1m resolution when the metric system is set. When depth is displayed in feet, 
the resolution is always 1 foot. Maximum operating depth is 120m/394ft.
No-stop time: calculated in real time and updated every 4 seconds. The maximum displayed no-stop time is 199 
minutes.

 WARNING
During all dives, perform a safety stop between 3 and 5 meters/10 and 15 feet for 3 to 5 minutes, even if no decompression 
stops are required.
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3 .2 Current dive settings

A short-press of the right button from the surface screen will give you access to your current dive settings. On the 
first screen information like MB-level or GF settings, water type, MOD, gas oxygen content will be displayed. With a 
further press of the right button the second screen of the current dive settings can be accessed where information 
like O2 content, ppo2 settings and MOD are displayed.

 

 

 

After ending a dive, the dive profile along with data like max depth, total dive time and temperature will be displayed. 
Press the left or right pushbuttons and start and end time of the dive. This information is the same information 
displayed in the LUNA 2.0’s internal logbook (see chapter Reading the logbook). By a long-press of the right 
button, you can quit the logbook information.
Additionally, after a dive there are further screens which can be accessed by pressing the left or right buttons. These 
screens display information like desaturation time, no-fly time, surface interval, CNS%, repetitive dive number and 
current and prohibited altitude classes.
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3 .3 Display configuration during the dive

Throughout the dive, the LUNA 2.0 always displays depth and dive time on the top row of the screen. Water 
temperature and no-stop time are shown on the bottom row. The information in the middle of the screen changes 
and you can scroll through the different screens with the pushbuttons. In the following sections you will learn what 
the LUNA 2.0’s screen looks like when diving in SCUBA, GAUGE and APNEA modes.

3 .4 Diving in SCUBA mode

In SCUBA mode, the following screens show the different dive-related information in the display’s matrix area which 
can be scrolled through using the two pushbuttons.

F	NOTE: The default information in the middle of the screen at the beginning of the dive is the No-Stop Time 
(NST). There is a timeout of 1 minute when displaying dive information other than the default, which sets you 
back to the NST or Deco stop screen.

Date and current time No -stop time and MB-level (ADT algorithm)

No -stop time and GF setting (GF algorithm) O2% and MOD
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MB-level and CNS% GF setting and CNS%

Timer Decompression stop

Level stop
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The Ascent/Descent symbol is used to indicate decompression and level stops during scuba dives.
• As long as there is no-stop time left, the symbol will not be shown.
• If you are at a depth deeper than the next level or deco stop, the wave symbol with the upwards arrow will be 

shown.

• If you are at the correct depth for the level or deco stop, the wave symbol with both upwards and downwards 
arrows will be shown.

• If you are at a depth shallower than the next level or deco stop, the wave symbol with the downwards arrow 
will be shown.

3 .5 Diving in GAUGE mode

When the LUNA 2.0 is set to GAUGE mode, it will only monitor depth, time, and temperature, and will not carry out 
any decompression calculations. Due to this there are fewer screens with dive-related information to scroll through 
than in SCUBA mode. You can only switch to GAUGE mode if the computer is completely desaturated. All audible 
and visual warnings and alarms, other than the low battery, max depth and max dive time are disabled.

 WARNING
Dives in GAUGE mode are performed at your own risk. After a dive in GAUGE mode, you must wait at least 48 hours before diving 
using a decompression computer.

When on the surface after a dive with GAUGE mode, the LUNA 2.0 will show neither the remaining desaturation 
time nor the CNS O2% value. It will, however, display a surface interval of up to 24 hours and a 48-hour no-fly time. 
The no-fly time is also the time during which you cannot change the dive mode. 
In GAUGE mode the following screens illustrate the different dive-related information in the matrix area of the display 
which can be scrolled through using the two pushbuttons. 

Date and current time Maximum and average depth
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Timer

F	NOTE: In Gauge and Scuba mode when the timer is displayed, it can be paused by a long-press of the right 
button. Another long-press of the right button will restart the timer. The timer can be reset to zero by a long-
press of the left button.

3 .6 Diving in APNEA mode

The LUNA 2.0 measures the depth in APNEA mode every 0.25 seconds to ensure the precise maximum depth. In 
the logbook the data is saved in 1-second intervals. In APNEA mode it is also possible to start and stop the dive 
manually with a long-press of the left button. This way you can use the LUNA 2.0 for static Apnea dives, where a 
normal dive start depth of 0.8 meters will not start a new dive.
If the APNEA mode is triggered manually by selecting St. Apnea in the Dive->Apnea menu, before the first 
immersion the LUNA 2.0 will show the surface interval counting in the middle of the display. 

Upon immersion the screen will show the dive time of the current immersion.

With the left or right pushbuttons you can switch to different screens where information like the total apnea exercise 
time, date and current time will be displayed. The current temperature (water or air) is always displayed in the 
bottom left area of the display.



42 LUNA 2.0 USER MANUAL

 

F	NOTE: When surfacing after an immersion the maximum depth of the most recent immersion will be displayed 
in the top left corner of the screen.

From the surface interval screen, you can access different information about your immersions, like number, maximum 
depth reached and total time of immersion:

 

After manually ending the apnea dive exercise by a long-press of the left pushbutton from the surface interval 
screen the display will show the following information:
• apnea dive profile
• maximum depth reached (5.4 m)
• total time of apnea dive exercise (8 minutes)
• average water temperature (24°C) 

As with GAUGE mode, the LUNA 2.0 in APNEA mode does not carry out any decompression calculations. You can 
only switch to APNEA mode if the computer is completely desaturated. Also, the LUNA 2.0 is locked in the APNEA 
mode for 12 hours after dives shallower than 5m. After deeper dives the lock period is 24 hours.
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Alarms and warnings in Apnea mode
In Apnea mode there is a set of alarms that can be enabled. See chapter Apnea mode settings to learn what each 
of these alarms represents and how to enable them. For surface interval and total apnea exercise depth alarms 
the LUNA 2.0 will display a message on its screen, for the rest of the alarms it will only emit an audible sequence.

 

3 .7 Safety stop timer

If a minimum depth of 10m/30ft is reached during the dive, at a depth of 5m/15ft the safety stop timer will 
automatically start a 3-minute countdown. If you go below 6.5m/20ft, the timer will disappear, and the no-stop time 
will be shown again. Upon returning to 5m/15ft, the timer will start again automatically.

F	NOTE: The safety stop timer is only available when diving in SCUBA mode.

3 .8 Activating the backlight

To activate the backlight on the surface as well as during diving, long-press the left and right buttons simultaneously. 
For setting the duration and intensity of the backlight refer to chapters Light-up and Light.

F	NOTE: The backlight is not available when the battery level is weak.

3 .9 Warnings during diving

The LUNA 2.0 can alert you to potentially dangerous situations through warnings and alarms. You can modify the 
warning and alarm settings in the menus or via LogTRAK.
Warnings represent situations that require your attention; however, ignoring them does not necessarily represent an 
immediate risk. It is up to you to decide which ones you would like to be active.
Warnings are shown on white background in the middle of the display. Additionally, audible signals are available 
when the sound function is enabled. You can also set a visual warning function, where the LUNA 2.0’s display 
backlighting would indicate if a warning was triggered. If this feature is enabled, the backlight will light up in bright 
red color for the duration of the respective warning. Refer to chapter Setting the visual warning signal to learn 
how to enable this feature.
If a warning is triggered it will automatically show up on the display. After a couple seconds it will disappear from 
the screen but you can still review all warnings and alarms that were triggered during the dive by scrolling through 
the different screens with the pushbuttons.
In the following sections the available warnings in the LUNA 2.0 are described.
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 WARNING
• When diving in GAUGE mode, all warnings are OFF except for max depth and max dive time warnings.
• When the LUNA 2.0 is set to silent mode (buzzer off), all audible warnings are muted.

3 .9 .1 Maximum depth 
If you have enabled the maximum depth warning, the following display will be shown when the selected depth is 
reached. Refer to chapter Dive depth warning to learn how to enable this warning.

3 .9 .2 CNS O2 = 75%
The LUNA 2.0 tracks your oxygen uptake via the CNS O2 clock. If the calculated value of CNS O2 reaches 75%, the 
LUNA 2.0 will emit a sequence of audible beeps for 12 seconds and the following display will be shown.

3 .9 .3 No-stop time = 2 min
If you wish to avoid unintentionally performing a decompression dive, the LUNA 2.0 can activate a warning when the 
no-stop time reaches 2 minutes. This applies to both L0 no-stop and MB no-stop time (see chapter Diving with 
MB-levels for more information). It gives you the opportunity to start ascending before incurring a decompression 
stop or a level stop obligation.



45

En
gl

is
h

LUNA 2.0 USER MANUAL

3 .9 .4 No-stop time = 0 min
The LUNA 2.0 can activate a warning when the first mandatory decompression stop appears. This alerts you to the 
fact that a direct ascent to the surface is no longer possible.

3 .9 .5 L0 no-stop = 2 min
When diving with a MB-level higher than L0, the underlying L0 information is not directly visible on the display 
(though it is accessible as alternate information). You can choose to have your LUNA 2.0 warn you when the 
underlying L0 no-stop time reaches 2 minutes while diving with an active MB-level higher than L0.

3 .9 .6 Entering decompression 
The LUNA 2.0 can activate a warning when the first mandatory decompression stop appears. This alerts you to 
the fact that a direct ascent to the surface is no longer possible. This warning applies to dives with the computer 
set to L0-L5.
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3 .9 .7 Dive time 
If you have enabled the dive time warning, this will be shown by a screen like the below when the time limit is 
reached. Refer to chapter Dive time warning to learn how to enable this warning.

When dive time warning is activated the LUNA 2.0 will alert you when it is time to turn around and start ascending 
to the surface.

3 .9 .8 100/100 no-stop = 2 min
When diving with GF setting other than 100/100, the underlying 100/100 information is not directly visible on the 
display (though it is accessible as alternate information). You can choose to have your LUNA 2.0 warn you when 
the underlying 100/100 no-stop time reaches 2 minutes while diving with an active GF setting other than 100/100.

3 .9 .9 Entering GF stops 
When diving with a GF setting other than 100/100, the LUNA 2.0 can warn you when you are no longer in the GF 
no-stop phase. For more information, see chapter Diving with Gradient Factors (GF).
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3 .9 .10 Entering decompression at 100/100 
When diving with a GF setting other than 100/100, the underlying 100/100 information is not directly visible on the 
display (though it is accessible as alternate information). You can choose to have your LUNA 2.0 warn you when 
you are about to enter a decompression obligation while diving with an active setting other than 100/100.

3 .9 .11 MB-level stop missed
When diving with a MB-level higher than L0 and in the presence of MB-level stops, the LUNA 2.0 can warn you if 
you reach a depth shallower than the deepest required MB-level stop, therefore allowing you to avoid missing the 
required stop.

3 .9 .12 GF stop missed
When diving with a GF setting other than 100/100 and in the presence of GF stops, the LUNA 2.0 can warn you 
if you reach a depth shallower than the deepest required GF stop, therefore allowing you to avoid missing the 
required stop.
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3 .9 .13 MB-level reduced
When diving with a MB-level higher than L0 and in the presence of MB-level stops, if you ascend more than 
1.5m/5ft above the deepest required MB-level stop, the LUNA 2.0 reduces your MB-level to the next possible level. 
The display will show the new active MB-level.

3 .9 .14 GF increased
When diving with a GF setting other than 100/100 and in the presence of GF stops, if you ascend more than 
1.5m/5ft above the deepest required GF stop, the LUNA 2.0 increases your GF to the next possible value. The 
display will show the new active GF setting.

3 .10 Alarms during diving

Alarms cannot be turned off as they represent situations that require immediate action.
Alarms are shown on a white background in the middle of the display. Additionally, audible signals are available 
when the sound function is enabled. You can also set a visual alarm function, where the LUNA 2.0’s display 
backlighting would indicate if an alarm was triggered. If this feature is enabled, the backlight will light up in bright 
red color for the duration of the respective alarm. Refer to chapter Setting the visual warning signal to learn how 
to enable this feature.
Alarms can be confirmed by pressing the right button, but they remain on the alternate display which can be 
scrolled through with the pushbuttons.
In the following sections the available alarms in the LUNA 2.0 are described.

 WARNING
• When diving in GAUGE mode, all alarms are OFF except for the low battery alarm.
• When the LUNA 2.0 is set to silent mode (buzzer off), all audible alarms are muted.
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3 .10 .1 Ascent rate
The LUNA 2.0 employs a variable ideal ascent rate. Its value ranges from 3 to 10m/min (10 to 33ft/min) and the 
actual breakdown by depth range is listed in the table below.

DEPTH ASC SPEED

m ft m/min ft/min

0 0 3 10

2.5 8 5.5 18

6 20 7 23

12 40 7.7 25

18 60 8.2 27

23 75 8.6 28

31 101 8.9 29

35 115 9.1 30

39 128 9.4 31

44 144 9.6 32

50 164 9.8 33

120 394 10 33

If you ascend too quickly, the resulting pressure reduction could lead to microbubble formation. If you ascend too 
slowly, the continued exposure to high ambient pressure means you will continue loading some or all of your tissues 
with nitrogen.
If the ascent rate is greater than 110% of the ideal value, the SLOW DOWN alarm is shown.

The ascent speed bar in the above screen represents the following:
1 bar -> speed = 20-40%
2 bars -> speed = 40-60%
3 bars -> speed = 60-80%%
4 bars -> speed = 80-100%
5 bars -> speed = 100-110%
6 bars -> speed > 110%
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3 .10 .2 MOD
If you exceed the maximum partial pressure of the selected gas, the following alarm is shown: MOD + DEPTH. The 
alarm remains active until you ascend to a depth where the ppO2 is within safe limits.

 WARNING
The MOD should not be exceeded. Disregarding the alarm can lead to oxygen poisoning. Exceeding a ppO2 of 1.6bar can lead 
to sudden convulsions resulting in severe injury or fatal issue.

3 .10 .3 CNS O2 = 100%
The LUNA 2.0 tracks your oxygen uptake via the CNS O2 clock. If the calculated value of CNS O2 reaches 100%, 
the LUNA 2.0 will emit a sequence of audible beeps for 12 seconds and the CNS 100% alarm will be shown.

 WARNING
When the CNS O2 reaches 100% there is danger of oxygen toxicity. Start the procedure to end your dive.

3 .10 .4 Missed decompression stop
If in the presence of a required decompression stop you ascend more than 0.5m/2ft above the required stop, the 
LUNA 2.0 will indicate an alarm: MISSED DECO. This will continue for as long as you stay 0.5m/2ft or more above 
the required stop.

 WARNING
Violating a mandatory decompression obligation may result in severe injury or fatal issue.
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3 .10 .5 Low battery alarm
During the dive the LUNA 2.0 will alert you if the battery level is getting critically low. This means you need to start 
the procedure to end the dive, as there is not enough energy in the battery to ensure the proper functions and the 
computer may fail. Some functions like backlight and audible / visual alarms are no longer available.

 WARNING
Do not start a dive if the battery symbol is blinking. The computer may fail to function during the dive and this could lead to 
severe injury or fatal issue.

3 .11 SOS

If you stay above a depth of 0.8m/3ft for more than 3 minutes without observing a mandatory decompression stop, 
the LUNA 2.0 will switch into SOS mode. Once in SOS mode the LUNA 2.0 will lock up and will be inoperable as a 
dive computer for 24 hours. If it is used for diving within the 24 hours of an SOS lock, it will automatically switch to 
GAUGE mode and provide no decompression information.

 WARNING
Violating a mandatory decompression obligation may result in severe injury or fatal issue. Severe injury or fatal issue may 
result if a diver does not seek immediate treatment should any signs or symptoms of decompression sickness occur after a 
dive. 
Do not dive to treat symptoms of decompression sickness. 
Do not dive when the computer is in SOS mode.

SOS in GAUGE mode SOS in SCUBA mode

3 .12 No-dive warning

If the LUNA 2.0 detects a situation of increased risk (due to potential microbubble accumulation from previous dives 

or a CNS O2 level above 40%), the NO DIVE symbol (   ) will appear to advise you against performing another 
dive right away. The suggested time interval that you should wait prior to diving again is shown in the top left corner 
section of the display after a dive. In the example below the recommended time to wait before performing another 
dive is 21 hours. 
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You should not undertake a dive as long as the no-dive warning is displayed on the computer screen. If the warning 
is prompted by microbubble accumulation (as opposed to CNS O2 over 40%) and you dive anyway, you will have 
shorter no-stop times or longer decompression times. Moreover, the duration of the microbubble warning at the 
end of the dive can increase considerably.

3 .13 No-fly time

The no-fly time is the time during which exposure to the reduced pressure (equal to ascending at higher altitudes) 
inside the cabin of an airplane could cause decompression sickness, as calculated by the decompression model 
in the computer. The no-fly symbol with countdown timer is shown in the top right corner of the display until the 
restriction is completed.

3 .14 Diving with MB-levels

Microbubbles are tiny bubbles that can build up inside a diver’s body during a dive and normally dissipate naturally 
during an ascent and on the surface after a dive. Dives within no-stop times or the observance of decompression 
stops do not prevent the formation of microbubbles in the venous blood circulation. 
Dangerous microbubbles are those migrating into the arterial circulation. The reasons for the migration from the 
venous blood circulation to the arterial circulation can be because of a build-up of microbubbles collecting in the 
lungs. SCUBAPRO has equipped the LUNA 2.0 with technology to help protect divers from these microbubbles. 
With the LUNA 2.0 you can choose – according to your specific needs – a MB-level that will provide a level 
of protection from microbubbles. Diving with MB-levels includes additional ascent stops which slow the ascent 
process, giving the body more time to desaturate. This works contrary to the formation of microbubbles and may 
increase safety. 
The LUNA 2.0 features 6 microbubble levels (L0-L5). Level L0 corresponds to SCUBAPRO’s well-known 
decompression model ZH-L16 ADT PMG and does not require additional stops due to microbubble formation. 
Levels L1 to L5 offer additional protection from microbubble formation, with level L5 offering the highest level and 
most protection. 
Similar to the display of information during decompression dives or dives within no-stop time, the LUNA 2.0 displays 
the depth and duration of the first level stop as well as the total time of ascent as soon as the MB no-stop time has 
run out. As the MB no-stop time is shorter than the ordinary no-stop time, you will be required to perform a stop 
sooner than a diver using level L0. 
If you ignore a required stop, the LUNA 2.0 will simply step down to a lower MB-level. In other words, if you 
choose level L4 prior to the dive, and during the dive you ignore the L4’s recommended stops, the LUNA 2.0 will 
automatically adjust the setting to level L3 or lower. 
Comparison of dives with MB-level L0 and MB-level L5
When two LUNA 2.0 dive computers are used simultaneously, with one unit set to a MB-level of L5 and the other 
to a MB-level of L0, the no-stop time for the L5 unit will be shortened and more stops will be required before the 
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L5 diver has the same obligation of a decompression stop as the L0 diver. These additional stops help dissipate 
microbubbles.

L0

L5

3 .15 PDIS (Profile-Dependent Intermediate Stops)

3 .15 .1 Introduction to PDIS

The main purpose of a dive computer is to track your nitrogen uptake and recommend a safe ascent procedure. 
Diving within the so-called no-stop limits means that at the end of the dive you can ascend directly to the surface, 
albeit at a safe ascent rate, while for dives outside of the no-stop limit (so-called decompression dives), you must 
perform stops at certain depths and allow time for excess nitrogen to be expelled from your body before finishing 
the dive and re-surfacing. 

In both cases, it can be beneficial to stop for a few minutes at an intermediate depth between the maximum depth 
attained during the dive and the surface or, in case of a decompression dive, the first (deepest) decompression 
stop. 

An intermediate stop of this kind is beneficial as soon as the ambient pressure at that depth is low enough to 
ensure that your body is predominantly off-gassing nitrogen, even if under a very small pressure gradient. In such 
a situation, you can still cruise along the reef and enjoy the dive while your body gets a chance to slowly release 
nitrogen. 

In recent times, so-called “deep” stops have been introduced in some dive computers and tables, defined as half 
the distance from the dive’s maximum depth and the surface (or the lowest decompression stop). Spending 2 or 
15 minutes at 30m/100ft would result in the same deep stop at 15m/50ft. 

With PDIS, as the name suggests, the LUNA 2.0 interprets your dive profile and suggests an intermediate stop that 
is a function of your nitrogen uptake so far. The PDI stop will therefore change over the course of the dive to reflect 
the continuously changing situation in your body. Along the same lines, PDIS will account for the accumulated 
nitrogen from previous dives; hence, PDIS is also repetitive-dive dependent. Conventional deep stops completely 
ignore these facts. 

The following figure quantifies the extent of PDIS and illustrates its dependence on cumulative nitrogen uptake 
for 2 sample dive profiles. This figure also demonstrates the conceptual difference between PDIS and the rather 
rudimentary “deep” stops. Specifically, the figure compares 2 dive profiles to a maximum depth of 40m/132ft that 
are otherwise very different. 

Profile 1 stays at 40m/132ft for 7 minutes, then ascends to 30m/100ft for 3 minutes, followed by 12 minutes 
at 20m/65ft. Profile 2 stays less than 2 minutes at 40m/132ft, then ascends to 21m/69ft and stays there for 33 
minutes. Both dive profiles are no-stop dives to the limit of entering decompression. 

The solid line represents the PDIS depth as displayed on the computer screen during the course of the dive for 
profile 1, the broken line represents the PDIS depth as displayed on the computer screen during the course of 
profile 2. One can see that the displayed PDIS depth increases as more nitrogen is accumulated in the body but 
does so very differently in the 2 dives due to the different exposure in the 2 profiles. The PDI stop is carried out at 
25 minutes for profile 1 and at 37 minutes for profile 2, followed by the safety stop at 5m/15ft.
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The line made up of small solid dots, on the other hand, represents the depth that would be displayed by a 
computer following the conventional deep stop method, and it would be the same for the 2 dive profiles. Deep 
stops completely ignore any facts about the dives themselves aside from max depth.
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3 .15 .2 How does PDIS work?

The mathematical decompression model in the LUNA 2.0, called ZH-L16 ADT MB PMG, tracks your decompression 
status by dividing your body into 16 so-called compartments and mathematically following the uptake and release 
of nitrogen in each with the appropriate laws of physics. The various compartments simulate parts of your body 
such as the central nervous system, muscles, bones, skin and so on. 

The depth of the PDI stop is calculated as that at which the leading compartment for the decompression calculation 
switches from on-gassing to off-gassing, and the diver is advised to perform a 2-minute stop above the displayed 
depth (this is the opposite of a decompression stop, where you are asked to remain just beneath the displayed 
depth). During this intermediate stop, the body is not taking up any more nitrogen in the leading compartment, 
but rather releasing nitrogen (though under a very small pressure gradient). This, combined with the relatively high 
ambient pressure, inhibits bubble growth. It should be noted that the 4 fastest compartments, up to 10-minute 
half-times, respectively, are not considered for the determination of the PDI stop depth. This is due to the fact that 
these compartments are only “leading” for very short dives, for which an intermediate stop is not required at all.

F	NOTE: The PDI stop is not a mandatory stop, and it is NOT a substitute for the 3- to 5-minute safety stop at 
5m/15ft.

 WARNING
Even when performing a PDI stop, you still MUST perform a safety stop at 5m/15ft for 3 to 5 minutes. Performing a 3- to 
5-minute stop at 5m/15ft at the end of any dive remains the best thing you can do for yourself.

3 .15 .3 Diving with PDIS

When the calculated PDI stop is deeper than 8m/25ft, the LUNA 2.0 shows it on the display and continues to do 
so until you reach the displayed depth during an ascent. The displayed value changes during the dive as the LUNA 
2.0 tracks the uptake of nitrogen in the 16 compartments and updates the PDIS depth accordingly to reflect the 
optimum at all times. 
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During a no-stop dive, as soon as you reach that depth during an ascent, a 2-minute countdown will appear. 

You can have one of these 3 situations: 

1. You have spent 2 minutes within 3m/10ft above the indicated depth. The countdown timer disappears, and 
you have successfully completed the PDIS. 

2. You have descended more than 0.5m/2ft below the PDIS. The countdown timer disappears and will reappear 
again, starting at 2 minutes, the next time you ascend to the PDIS depth. 

3. You have ascended more than 3m/10ft above the PDIS. The PDIS value and countdown timer disappears and 
PDIS has not been performed.

F	NOTE: The LUNA 2.0 issues no warnings relating to a missed PDI stop. When diving with MB-levels, PDIS 
follows the same rules as described above. MB-levels, however, introduce stops earlier and deeper than the L0 
base algorithm. As such, the PDIS display may be delayed and, for certain dives, it may not be displayed at all. 
This, for example, would be the case for a shallow dive with air (21% oxygen) and a MB-level L5.

3 .16 Diving with Gradient Factors (GF)

The technical diving community, in particular, finds that the Gradient Factors approach best suits their diving needs. 
So, in an effort to address these preferences the LUNA 2.0’s software can be set to use GF settings. 

Bühlmann created the ZH-L16C base algorithm. In the ‘90s Erik Baker presented the Gradient Factors (GF) 
approach, which provides additional options for increased conservatism. Gradient Factors can be set from no 
conservatism at all (100/100) to many different combinations. 

In the Gradient Factor format “low/high” both values “low” and “high” present the percentual amount of the base 
algorithm limiting M-value. The “low” defines the conservatism on fast compartments which will start desaturation at 
ascent first, whereas the “high” becomes dominant on shallower depths before surfacing. Due to the many possible 
combinations, it is possible to define your own decompressing strategy.

F	NOTE: For a more detailed explanation of the Gradient Factors and their meaning, please refer to Erik Baker’s 
articles: “Clearing Up the Confusion About Deep Stops” and “Understanding M-values”.

 WARNING
Diving with the Gradient Factor algorithm requires advanced know-how about decompression theories, their suitability for the 
planned dives and matching to your body. Wrong values can lead to decompression sickness, severe injury or death. Do not 
dive with Gradient Factors until you have the necessary knowledge and qualifications!
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3 .17 Altitude diving

3 .17 .1 Altitude warning after a dive

Climbing to altitude is similar to starting an ascent from a dive: you expose your body to a lower partial pressure 
of nitrogen, and you start off-gassing. After a dive, given the higher nitrogen loading in your body, even reaching 
an otherwise negligible altitude can potentially cause decompression sickness. Consequently, the LUNA 2.0 
constantly monitors the ambient pressure and uses it to evaluate your nitrogen loading and off-gassing. If the LUNA 
2.0 notices a drop in ambient pressure not compatible with your current nitrogen loading, it will activate a warning 
(altitude symbol starts blinking) to alert you of a potentially dangerous situation. 

The LUNA 2.0 counts down remaining saturation and indicates this on the current dive settings screen with the no-
fly time until the available saturation is no longer dangerous during a flight or when crossing over a mountain pass. 

The allowable altitude (beyond which the LUNA 2.0 has computed to be incompatible with your current nitrogen 
saturation levels) is displayed below the no-fly time and the surface interval. Refer to chapter Reading the altitude, 
barometric and temperature values for more information.

3 .17 .2 Altitude and the decompression algorithm

Atmospheric pressure is a function of altitude and weather conditions. This is an important aspect to consider 
for diving because the surrounding atmospheric pressure has an influence on the on-gassing and off-gassing of 
nitrogen in your body. The LUNA 2.0 divides the possible altitude range into 5 classes that are illustrated in the 
picture below:

Elevation Barometric 
switch point

Dive modeAltitude classes

C0

C1

C2

C3

C4
4000 m
13120 ft
3000 m
9840 ft

2000 m
6560 ft
1000 m
3280 ft

0 m
0 ft

610 mbar
8.85 psi

725 mbar
10.51 psi

815 mbar
11.82 psi

905 mbar
13.13 psi

GAUGE

SCUBA

SCUBA

SCUBA

SCUBA

Altitude classes Elevation Barometric 
switch point

GAUGE610 mbar
8.85 psi

4000 m
13120 ft

SCUBA725 mbar
10.51 psi

3000 m
9840 ft

SCUBA815 mbar
11.82 psi

2000 m
6560 ft

SCUBA905 mbar
13.13 psi

1000 m
3280 ft

0 m
0 ft

SCUBA

Dive mode

The altitude classes are approximate elevations because the effect of weather conditions can make the switch point 
pressure occur at different levels.

 WARNING
At the altitude class 4 or higher the LUNA 2.0 operates in GAUGE mode only (the mode will switch automatically).

F	NOTE: You can check your current altitude class and elevation in the Altimtr menu.

F	NOTE: The LUNA 2.0 deals with altitude automatically - it monitors the atmospheric pressure every 60 seconds 
and if it detects a sufficient drop in pressure, it does the following: it indicates the new altitude range and, if 
applicable, the prohibited altitude range; it indicates the desaturation time, which in this case is an adaptation 
time to the new ambient pressure. If a dive is started during this adaptation time, the LUNA 2.0 considers it a 
repetitive dive since the body has residual nitrogen.

F	NOTE: A fast descent from mountains or a fast rise in airplane cabin pressure may activate the dive mode. The 
LUNA 2.0 will automatically detect and end this “dive” after 12 hours, or you may manually end it by a long-
press of both pushbuttons at the same time. This kind of false dive will not be stored in the LUNA 2.0’s logbook.
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3 .17 .3 Prohibited altitude

Going to altitude, as well as flying after diving, exposes your body to reduced ambient pressure. In a manner similar 
to no-fly time, the LUNA 2.0 advises you of the safe altitudes you can reach after a dive, and those which are not 
safe. If you have to drive over a mountain pass to return home after a dive, this information can be quite important, 
and you can check this information in the dive planner.

The current altitude class is shown in the middle on the bottom row and the prohibited altitude is shown on the right. 
In the example above, the diver is presently at altitude class 0 and should not reach altitudes above 4000m (class 
4) within the given surface interval of thirty minutes. By increasing the interval time on the middle row, the allowed 
altitude increases due to the desaturation caused by the time spent at the current altitude class.

 WARNING
If atmospheric pressure is below 610mbar (altitude higher than 4000m/13300ft), no decompression calculation is carried out 
by the LUNA 2.0, and it will not start in SCUBA mode, but in GAUGE mode. In addition, the dive planner is not available at this 
altitude.

3 .17 .4 Decompression dives in mountain lakes

In order to ensure optimal decompression even at higher altitudes, the 3m/10ft decompression stage is divided into 
a 2m/7ft stage and a 4m/13ft stage in altitude ranges 1, 2 and 3. 

If atmospheric pressure is below 610mbar (altitude higher than 4000m/13300ft), no decompression calculation is 
carried out by the LUNA 2.0 (automatic GAUGE mode). In addition, the dive planner is not available in this altitude 
class.

3 .18 Diving with Nitrox 

Nitrox is the term used to describe breathing gases made of oxygen-nitrogen mixes with oxygen percentages 
higher than 21% (air). Because nitrox contains less nitrogen than air, there is less nitrogen loading on the diver’s 
body at the same depth as compared to breathing air. 

However, the increase in oxygen concentration in nitrox implies an increase in oxygen partial pressure in the 
breathing mix at the same depth. At higher than atmospheric partial pressures, oxygen can have toxic effects on 
the human body. These can be grouped into 2 categories: 

1. Sudden effects due to oxygen partial pressure over 1.4bar. These are not related to the length of the exposure 
to high oxygen partial pressure. Sudden effects can vary and depend on the exact level of partial pressure 
they happen at. It is commonly accepted that partial pressures up to 1.4bar are tolerable during the active part 
of the dive, and maximum oxygen partial pressures up to 1.6bar during the decompression. 

2. Long exposure effects due to oxygen partial pressures over 0.5bar due to repeated and/or long dives. These 
can affect the central nervous system and cause damage to lungs or to other vital organs. Long exposures 
can be divided between more severe Central Nervous System effects and less dangerous long-term 
Pulmonary Toxicity effects. The LUNA 2.0 treats high ppO2 and long exposure effects in the following ways:

Against sudden effects: The LUNA 2.0 has an MOD alarm set for a user-defined ppO2max. As you enter the 
oxygen concentration for the dive, the LUNA 2.0 shows you the corresponding MOD for the defined ppO2max. 
The default value of ppO2max from the factory is 1.4bar. This can be adjusted to your preference between 1.0 and 
1.6bar. It can also be turned off. Please refer to chapter Setting gas oxygen content for more information on how 
to change this setting. 

Against long exposure effects: The LUNA 2.0 “tracks” the exposure by means of the CNS O2 clock. At levels 
of 100% and higher there is risk of long exposure effects, and consequently the LUNA 2.0 will activate an alarm 
when this level of CNS O2 is reached. The LUNA 2.0 can also warn you when the CNS O2 level reaches 75%. Note 
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that the CNS O2 clock is independent of the value of ppO2max set by the user. The CNS O2 75% warning and 
CNS O2 100% alarm can be activated during a dive (see chapters CNS O2 = 75% and CNS O2 = 100% for more 
information), whereas the remaining CNS O2 value after a dive is shown in the current dive settings display in the 
mid-section of the bottom row (4% in below example).

The CNS O2 clock increases when the oxygen partial pressure is higher than 0.5bar, and decreases when the 
oxygen partial pressure is lower than 0.5bar. Hence, while on the surface breathing air you will always be decreasing 
the CNS O2 clock. During the dive, the depth at which 0.5bar is reached for various mixes is as follows: 

• Air: 13m/43ft 
• 32% O2: 6m/20ft 
• 36% O2: 4m/13ft

F	NOTE: For oxygen concentrations of 80% and higher, the ppO2max is fixed at 1.6bar and cannot be changed.

3 .19 Diving with multiple gas mixtures 

The LUNA 2.0 is equipped with the ZH-L16 ADT MB PMG algorithm. PMG stands for Predictive Multi-Gas, 
meaning that when you program more than one gas mixture, the LUNA 2.0 will predict the switch to the higher 
oxygen concentration gas at the depth that you specified and keep you informed at all times with a comprehensive 
decompression schedule of all the gas mixtures that you programmed. 

In other words, you get full credit at any point during the dive for all the extra gas mixtures that you are carrying 
with you.

F	NOTE: See chapter Enabling predictive multi-gas mode (PMG) to learn how to enable this mode on your 
LUNA 2.0.

 WARNING
VERY IMPORTANT! 
Diving with multiple gas mixtures represents a much higher risk than diving with a single gas mixture, and mistakes by the 
diver may lead to severe injury or death. 
During dives with multiple gas mixtures, always make sure you are breathing from the tank that you intend to use. Breathing 
from a high oxygen concentration mix at the wrong depth can kill you. 
Mark all your regulators and tanks so that you cannot confuse them under any circumstances. 
Before each dive and after changing a tank, ensure that each gas mixture is set to the correct value for the corresponding tank. 
Get the proper training and certifications to make multi-gas dives prior to making them by yourself. 
The LUNA 2.0 enables you to use up to 3 gas mixtures during the dive. 
For oxygen concentrations of 80% and higher, the ppO2max is fixed at 1.6bar and cannot be changed. 
The MOD for tanks 2 and 3 are the switch depths for those gases. This is what the LUNA 2.0 uses for its calculations, warnings, 
and suggested switch points. 
When diving with more than 1 gas mixture, the nitrox reset time function (described in the chapter Nitrox reset time) has the 
following effect: gas 1 is set to 21%, gases 2 and 3 are set to OFF. 

 WARNING
Start breathing from the tank with the new gas mixture before confirming a switch. Always make sure you are switching to the 
intended gas. Failure to do so may result in severe injury or death.

The following sections about gas switching are shown with 2 gas mixtures enabled. However, more than two mixes 
enabled function similarly.
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Diving with 2 gas mixtures

3 .19 .1 Switching gas mixture during the dive 

During the ascent phase, when you reach a depth corresponding to the MOD of a gas other than the one you are 
currently using, the LUNA 2.0 will suggest that you perform the switch. An audible sequence is played, and the 
suggested gas switch appears on the display. You have 30 seconds to respond to this message, otherwise the 
LUNA 2.0 will conclude that gas 2 will not be used and adapt the decompression schedule accordingly.

To confirm the gas switch, long-press the right button. 
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3 .19 .2 Switching back to a gas mixture with lower oxygen concentration 

There may be situations where you have to switch back to a tank with lower oxygen concentration. This can 
happen, for instance, if you want to descend again below the MOD of the higher oxygen concentration gas (T2), 
or if you have run out of T2 gas during decompression. At this point you can manually initiate the gas switch by 
long-pressing the right button.

Long-press the right button to confirm the switch or short-press the right or left buttons to select a different gas 
mixture.

3 .19 .3 Gas switch not carried out at the planned depth

If you fail to confirm the gas change within the 30 seconds of when the LUNA 2.0 suggests it, the gas is excluded 
from the decompression calculation and the decompression schedule is adapted accordingly, basically reflecting 
the fact that you will finish the dive without using the excluded gas.

3 .19 .4 Delayed gas switch 

You can catch up on a planned gas mixture switch at any time by selecting the gas manually. Press-and-hold the 
right button to start the gas switch procedure. The LUNA 2.0 will display the tank and its oxygen concentration. This 
helps you verify that you are performing a switch to a safe gas. At this point you would long-press the right button 
to confirm the switch. The LUNA 2.0 will display the message GAS CHANGE SAVED and adapt the decompression 
schedule accordingly.

3 .19 .5 Submerging below the MOD after a gas switch

If, after having switched to gas T2, you inadvertently drop again below the MOD for that mixture, the MOD alarm 
will immediately be activated. In this case, you would either switch back to gas T1 or ascend above the MOD for 
gas T2.
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3 .20 Setting bookmarks

With a long-press of the left button you can set any number of bookmarks as reminders of particular moments 
during the dive. The bookmarks will appear on the dive profile in SCUBAPRO LogTRAK.

4 . LUNA 2.0 ACCESSORIES

4 .1 Silicone protection cover

The LUNA 2.0 comes with a pre-mounted silicone cover that will protect it from drop or blows. This protective 
cover is removable and can be purchased separately from your authorized SCUBAPRO dealer should it need to 
be replaced.

4 .2 Bungee arm straps

Divers wearing thick neoprene wetsuits or drysuits may prefer bungee mounting instead of a standard arm strap. 
The LUNA 2.0 is designed so that bungees can be affixed at the corners of the device for maximum stability.
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The silicone arm strap can be removed by unscrewing the hex head screws at the corners of the arm strap fixture, 
like in the following illustration.

4 .3 Bluetooth USB dongle

PCs and laptops with a Bluetooth driver version lower than 4.0 require a generic Bluetooth dongle 4.0 or higher in 
combination with Windows® operating system 8 or higher.
With older operating systems a BlueGiga type dongle is required.

5 . INTERFACES FOR THE LUNA 2.0 AND AN INTRODUCTION TO LOGTRAK

5 .1 Establishing Bluetooth communication

The LUNA 2.0 can be connected via Bluetooth to a desktop computer, laptop or handheld device for downloading 
dive data, configuring dive computer settings, writing owner information, or uploading firmware updates.
From the main menu, toggle down to Bluetooth using the right button. Long-press the right button to initialize the 
connection. 

At this point the LUNA 2.0 is ready for Bluetooth communication. Bluetooth is active only when the following screen 
is displayed.
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To establish Bluetooth communication with another device, set the device you want your LUNA 2.0 to communicate 
with (e.g. an iOS® or Android™ handheld device) to “scanning” mode. The first time you do this will require entering 
a pin code to ensure secure communication. This pin code is randomly generated by your LUNA 2.0 and is 
displayed on its screen as shown below. 

Once the code is accepted by the device you want to connect to, the link is ready for communication.

F	NOTE: The LUNA 2.0 has a timeout of 3 minutes for a non-active Bluetooth connection. After this interval, the 
LUNA 2.0 will disable Bluetooth and return to the surface screen to save energy.

5 .2 SCUBAPRO LogTRAK

SCUBAPRO LogTRAK is an advanced tool for keeping track of your dives. It is available for desktop computers 
(Windows® and Mac®) as well as for mobile devices (Android™ and iOS®).

5 .2 .1 SCUBAPRO LogTRAK desktop version
Download and install LogTRAK desktop version from www.scubapro.com/software-firmware. Consult the Read 
First text file found in the download package for instructions on how to install.
To establish communication with a desktop computer:
1. Connect your LUNA 2.0 to your desktop computer as described in the chapter Establishing Bluetooth 

communication.
2. Launch LogTRAK on your desktop computer.
3. Check that the LUNA 2.0 is detected by LogTRAK in Extras -> Options -> Download. 
4. If it is not automatically detected, run the “Rescan plugged device.”
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The desktop version of LogTRAK offers the following main functions:
• Download dives.
• Import and export dive profiles. 
• Access device information (ID, hardware, and software versions, etc.).
• Enable/disable warnings.
• Enter owner and emergency contact information.
• User information (gender, birthday, etc.).
• Unit settings (metric/imperial).
You can find a detailed description of the features and functions of LogTRAK desktop version under Help -> Help 
Contents or by pressing F1 in LogTRAK.

5 .2 .2 SCUBAPRO LogTRAK 2.0 mobile application
SCUBAPRO LogTRAK 2.0 is the mobile dive logbook for Android™ and iOS® devices. LogTRAK 2.0 allows you to 
download and analyze your dive profile data on most mobile devices. You can download the application from the 
App Store for iOS® and from the Google Play Store for Android™.

To establish connection with your LUNA 2.0, you need to enable Bluetooth on your mobile device and set your dive 
computer to Bluetooth mode.
LogTRAK 2.0 is the perfect way to view your dives, keep them organized on your mobile device and easily access 
them wherever you go.
Features include:
• Download and manage your dives.
• Analyze data like depth and temperature.
• Incorporate additional dive information.
• Adjust dive computer settings.

• Dive settings
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• Air settings
• Personalize your preferences (warnings, units, etc.).
• Update dive computer firmware.

6 . TAKING CARE OF YOUR LUNA 2.0

6 .1 Technical information

Operating altitude: 
with decompression – sea level to approximately 4000m/13300ft.
without decompression (Gauge mode) – at any altitude.

Max operating depth: 
120m/394ft; resolution is 0.1m until 99.9m, and 1m at depth deeper than 100m. Resolution in feet is always 1ft. 
Accuracy complies with EN13319 and ISO 6425.

Decompression calculation range: 
0.8m to 120m / 3ft to 394ft.

Clock: 
quartz clock, time, date, dive time display up to 999 minutes.

Oxygen concentration: 
adjustable between 21% and 50% for Gas 1.
.21% and 100% for Gas 2 and Gas 3.

Operating temperature: 
-10C° to +50C° / 14F° to 122F°.

Power supply:
Lithium type CR2450 battery.

Operation time with fresh battery: 
Up to 2 years. Actual battery operation time depends primarily on the operational temperature and backlight 
settings, but also on many other factors. 

Bluetooth® transceiver:
Operating frequency 2402-2478 MHz, max power < 3 dBm, connection range up to approx. 2m.

6 .2 Maintenance

The dive computer’s depth accuracy should be verified every 2 years by an authorized SCUBAPRO dealer. The last 
service date can be checked from the main menu: Settings -> User -> Service.

Aside from that, your LUNA 2.0 is virtually maintenance-free. All you need to do is rinse it carefully with fresh water 
after each dive and replace the battery when needed.

To avoid possible problems with your dive computer, the following recommendations will help ensure years of 
trouble-free service:
• Avoid dropping or jarring your dive computer.
• Do not expose your dive computer to intense, direct sunlight.
• Do not store your dive computer in a sealed container; always ensure free ventilation.
• If there are problems with the water contacts, use soapy water to clean your dive computer and dry it 

thoroughly.
• Do not use silicone grease on the water contacts!
• Do not clean your dive computer with liquids containing solvents.
• Check the battery capacity before each dive.
• If the battery warning appears, have the battery replaced by an authorized SCUBAPRO dealer.
• If any error message appears on the display, take your dive computer back to an authorized SCUBAPRO dealer.

6 .3 Updating the firmware of your LUNA 2.0

In order to update the operating software on your LUNA 2.0 dive computer, you need to download the SCUBAPRO 
LogTRAK mobile application.
To perform a software update, follow these steps:
1. Turn on Bluetooth on you dive computer,
2. Make sure you have Bluetooth enabled on your mobile device,
3. Open SCUBAPRO LogTRAK 2.0 mobile application,
4. Navigate to Equipment in LogTRAK 2.0,

a) First time: Press Add new and select your dive computer. Enter the pin shown on your dive computer’s 
screen.

b) Already added dive computer: Select your dive computer from the list.
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5. Select Firmware update 
available. 

6. Press Download Firmware. 7. Press Firmware Version XX 
install to start the installation 
process.

Your LUNA 2.0 shows the transfer status on the display with a progress bar.

After successful software download the LUNA 2.0 starts reprogramming automatically.

F	NOTE: The LUNA 2.0 will check the battery status before the update process. If the battery level is too low, the 
software update cannot be started. In order to update your LUNA 2.0, the battery must first be replaced.
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6 .4 Replacing the battery in the LUNA 2.0

 WARNING
The battery of the LUNA 2.0 is user-replaceable. The change must be made with particular care in order to prevent water from 
seeping in. The warranty does not cover damages due to an improper placement of the battery.
LUNA 2.0 stores the tissue saturation information in non-volatile memory, so the battery can be replaced at any time between 
dives without loss of information.

 WARNING
• A leaking battery compartment cover may lead to the destruction of your LUNA 2.0 by water seeping in or may cause it to 

switch off without prior notice.
• Always open the battery compartment in a dry and clean environment.
• Only open the battery compartment to replace the battery. 

Procedure:
• Dry the dive computer with a soft towel.
• Remove the silicone protection cover.
• Unscrew the two screws of the battery compartment cover with a suitable 1.5mm screwdriver.
• Carefully remove the old O-ring. Do not damage the sealing surfaces.
• Remove the old battery. Do not touch the battery contacts!
• Lubricate the O-ring with standard silicone grease.
• Slide the O-ring over the sealing surface on the battery cover.

 

 IMPORTANT
Always insert a new O-ring when replacing the battery and discard the old O-ring. Make sure that the new O-ring is in good 
condition and that the O-ring and sealing surfaces are free of dust and dirt. If necessary, clean the parts with a soft, lint-free 
cloth. Only use original SCUBAPRO O-rings.

• Check the correct polarity of the battery before inserting it. LUNA 2.0 can be damaged if batteries are 
inserted incorrectly. Insert the new battery with the “+” facing up. After the battery has been replaced, the 
dive computer will perform an automatic test (appr. 8 seconds) and a short beep will sound when the test is 
complete.

• Place the battery compartment cover back on. Alignment circles are used to position the lid correctly.
• Screw the battery compartment cover back using the same two screws. Tighten the screws alternately until 

finger tight.
• Avoid self-tapping screws to cut new threads.
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 WARNING
If the screw connection is forced, the screws can break off. Damage to the dive computer caused by an improperly replaced 
battery is not covered by the warranty.

F	NOTE: For best results use the battery set available at your authorized SCUBAPRO dealer.

6 .5 Screen protector

Your LUNA 2.0 comes with a factory-installed screen protector. This foil can be easily replaced if needed.

F	NOTE: When replacing the protection foil on the LUNA 2.0’s display, take care not to cover the water contacts! 

F	NOTE: If air bubbles get stuck underneath the protection foil when placing it on your LUNA 2.0’s glass face, do 
not try to remove them as the water pressure will eliminate them after the first dive.

6 .6 Warranty

The LUNA 2.0 has a 2-year warranty covering defects in workmanship and functioning for recreational use and 
1 year for rental or commercial use. The warranty only covers dive computers which have been bought from an 
authorized SCUBAPRO dealer. Repairs or replacements during the warranty period do not extend beyond the 
warranty period itself.

Excluded from warranty coverage are faults or defects due to:
1. Excessive wear and tear.
2. Exterior influences, e.g. transport damage, damage due to bumping and hitting, influences of weather or other 

natural phenomena.
3. Servicing, repairs or the opening of the dive computer by anybody not authorized to do so by the 

manufacturer.
4. Pressure tests which do not take place in water.
5. Diving accidents.
6. Opening the housing.
7. Commercial use.
8. Exposing the unit to chemicals which include but are not limited to mosquito repellents and sunscreen.
9. Repairing with unauthorized spare parts.
10. Using any software or accessory which is not supplied by the manufacturer

For European Union markets, the warranty of this product is governed by European legislation in force in each EU 
member state.

All warranty claims must be returned with dated proof-of-purchase to an authorized SCUBAPRO dealer. Visit 
www.scubapro.com to find your nearest dealer.
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7 . COMPLIANCE

7 .1 CE regulatory notices

7 .1 .1 EU Radio Equipment Directive

Hereby, Uwatec AG, declares that the radio equipment type PAN1740 is in compliance with Directive 2014/53/EU.

7 .1 .2 EU Depth Gauge Standard
The LUNA 2.0 dive instrument is also compliant with the European standard EN13319:2000 (EN 13319:2000 
– Depth gauges and combined depth and time measuring devices – Functional and safety requirements, test 
methods).

7 .1 .3 EU Electromagnetic Compatibility Directive
The LUNA 2.0 dive instrument is also compliant with the European Union directive 2014/30/EU.

7 .1 .4 EU Declaration of Conformity 
The full text of the EU declaration of conformity is available at www.scubapro.com/declarations-conformity.

7 .2 FCC & ISED regulatory notices 

7 .2 .1 Modification Statement 
Uwatec has not approved any changes or modifications to this device by the user. Any changes or modifications 
could void the user’s authority to operate the equipment.

7 .2 .2 Interference Statement 
This device complies with Part 15 of the FCC Rules and Industry Canada license-exempt RSS standard(s). Operation 
is subject to the following two conditions: (1) this device may not cause interference, and (2) this device must accept 
any interference, including interference that may cause undesired operation of the device.

7 .2 .3 Wireless Notice 
This device complies with FCC/ISED radiation exposure limits set forth for an uncontrolled environment and meets 
the FCC radio frequency (RF) Exposure Guidelines and RSS‐102 of the ISED radio frequency (RF) Exposure rules. 
This transmitter must not be co-located or operated in conjunction with any other antenna or transmitter.
The LUNA 2.0 contains FCC ID: T7V1740A. The FCC ID can be displayed electronically in SETTINGS->USER-
>SERVICE.

7 .2 .4 FCC Class B Digital Device Notice 
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed 
and used in accordance with the instructions, may cause harmful interference to radio communications. However, 
there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful 
interference to radio or television reception, which can be determined by turning the equipment off and on, the user 
is encouraged to try to correct the interference by one or more of the following measures:
1. Reorient or relocate the receiving antenna.
2. Increase the separation between the equipment and receiver.
3. Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
4. Consult the dealer or an experienced radio/TV technician for help.

7 .2 .5 CAN ICES-3 (B) / NMB-3 (B)
This Class B digital apparatus complies with Canadian ICES-003.

7 .3 Date of manufacture 

The manufacturing date can be determined from your device’s serial number. The serial number is always 13 
characters long: YYMMDDXXXXXXX.
In the serial number the first two digits (YY) represent the year, the third and fourth (MM) the month, and the fifth and 
sixth (DD) the day when the device was manufactured.
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7 .4 Manufacturer

UWATEC AG
Bodenaeckerstrasse 3
CH-8957 Spreitenbach
SWITZERLAND

7 .5 Markings

The markings in the above image represent the following:
• CE - European Community
• 1704220815001 - Serial number
• LUNA 2.0 - Product name

•  - Waste from Electrical and Electronic Equipment (WEEE)

Your dive instrument is manufactured with high-quality components that can be recycled and reused. Nevertheless, these components, if not 
properly managed in accordance with the regulations on electrical and electronic equipment waste, are likely to cause harm to the environment 
and/or to human health. Customers living in the European Union can contribute to protecting the environment and health by returning old 
products to an appropriate collection point in their neighborhood in accordance with EU Directive 2012/19/UE. Collection points are provided by 
some distributors of the products and local authorities. Products marked with the recycling symbol on the left must not be disposed of in normal 
household waste.
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8 . GLOSSARY

AVG Average depth, calculated from the beginning of the dive or from the time of reset

CNS O2 Central Nervous System oxygen toxicity

DESAT Desaturation time. The time needed for the body to completely eliminate any nitrogen taken 
up during diving

Dive time The time spent below a depth of 0.8m/3ft

Gas Refers to the main gas that is set for the ZH-L16 ADT MB PMG or ZH-L16C+GF PMG 
algorithm

GF Gradient Factor. Gradient factors are a way to introduce conservatism to the base 
algorithm and they are expressed in % values in format low/high 

INT. Surface interval, the time from the moment the dive is closed out

Max depth Maximum depth attained during the dive

MB Microbubbles: Microbubbles are tiny bubbles that can build up in a diver’s body during and 
after a dive

MB-level One of the 6 steps, or levels (L0 to L5), in SCUBAPRO’s customizable algorithm

MOD Maximum Operating Depth. This is the depth at which the partial pressure of oxygen 
(ppO2) reaches the maximum allowed level (ppO2max). Diving deeper than the MOD will 
expose the diver to unsafe ppO2 levels

Nitrox A breathing mix made of oxygen and nitrogen, with the oxygen concentration being 22% 
or higher. In this manual, air is considered as a particular type of nitrox

NO DIVE Minimum amount of time the diver should wait before performing another dive

NO FLY Minimum amount of time the diver should wait before taking a plane or ascending to 
altitudes higher than 2000m/6562ft

No-stop time 
(NST)

This is the time that a diver can stay at the current depth and still make a direct ascent to 
the surface without having to perform decompression stops

O2 Oxygen

O2% Oxygen concentration used by the computer in all calculations

PDIS Profile Dependent Intermediate Stop is an additional deep stop which is suggested by the 
dive computer at a depth where the 5th, 6th or 7th compartment starts off-gassing

PMG Predictive Multi-Gas. It lets you carry additional breathing gases in addition to your main 
breathing gas

ppO2 Partial pressure of oxygen. This is the pressure of the oxygen in the breathing mix. It is 
a function of depth and oxygen concentration. A ppO2 higher than 1.6bar is considered 
dangerous

ppO2 max The maximum allowed value for ppO2. Together with the oxygen concentration, it defines 
the MOD

OTU Oxygen Toxicity Unit. It is the degree of pulmonary oxygen toxicity produced by breathing 
100% O2 continuously at a pressure of 1 atmosphere absolute (ATA) for 1 minute

SOS mode The result of having completed a dive without respecting all mandatory decompression 
obligations

SURF INT Surface interval. The time that starts at the moment the dive is closed out

Switch point The depth at which the diver plans to switch to a higher oxygen concentration mix while 
using the multi-gas option

TAT Total Ascent Time. It is the time it should take the diver to get to the surface from their 
present depth

UTC Universal Time Coordinated, refers to time zone changes when traveling
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